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Notices about this Users Manual

-Please read this manual carefully before using the product.

-This manual can not be reprinted, so please keep it in a safe place.

-We cannot guarantee nor or we responsible for safety if this product is used in any man-
ner other than was intended.

-Please follow the safety precautions carefully.

-Contents of this manual may be altered according to improvements made to the product
without notification.

-On screen messages in this manual may vary slightly from the actual messages.
-Figures in this manual may be slightly simplified and may differ from the actual product.
-Please notify us of any unclarities, mistakes or errors in this manual.

-Reproduction or use of any part or all of this manual is strictly forbidden.

-Please carefully read the guarantee and provisions for free repair.

-Microsoft and Windows are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

-Windows Vista is either a registered trademark or trademark of Microsoft Corporation in
the United States and/or other countries.

-Company names and product names are trademarks or registered trademarks of each
company.

FCC Compliance Statement for American Users

This device complies with Part 15 of the FCC Rules.

Operation is subject to following two conditions: (1) this device may not cause harmful interference. and
(2) this device must accept any interference received, including interference that may cause undesired
operation.

NOTE:

This equipment has been tested and found to comply with the limits for a Class A Digital Device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

-- Reorient or relocate the receiving antenna.

-- Increase the separation between the equipment and receiver.

-- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

-- Consult the dealer or an experienced radio/TV technician for help.

Warning

This equipment has been verified to comply with the limits for a Class A personal digital device,
pursuant to Subpart B of Part 15 of FCC Rules. Only peripherals (computer input/output devices,
terminals, printers, etc.) certified or verified to comply with the Class A or B limits may be attached to
this equipment. Operation with non-certified or non-verified personal computer and/or peripherals is
likely to result in interference to radio and TV reception. The connection of a non-shielded equipment
interface cable to this equipment will invalidate the FCC Certification of this device and may cause
interference levels which exceed the limits established by the FCC for this equipment.

You are cautioned that changes or modifications not expressly approved by party responsible for
compliance could void your authority to operate the equipment.
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Safety Precautions and Instructions

Please follow these instructions carefully.

/\ Warnings

- This product has been designed for private or industrial use only. It is not for use in
situations where strict safety precautions are necessary such as in connection with
medical equipment whether directly or indirectly.

- We are not responsible for any malfunction or trouble caused by the use of our product
or by any problem caused by the malfunction of our unit. Please understand this before
using our product.

- Leakage of water or other foreign objects into the unit may cause fire or malfunctioning. If
something does leak into the unit make sure to remove the batteries immediately.

- Maintenance or modification of the main unit by anyone other than our authorized
mechanics is strictly prohibited. This could lead to malfunctioning.

- Avoid smoke, steam, high humidity and dust. These could lead to malfunctioning.

- It is extremely dangerous to swallow batteries. Install and keep all batteries, sensors and
the Thermo Recorder Unit a safe distance from and out of the reach of small children.

- The Thermo Recorder is a device designed to measure and record temperature. Do not
use this unit for any purpose other than temperature measurement.

- The sensor may have a sharp edge, please take care when handling it.

/\ Handling Precautions

- Dropping the unit or exposing it to a strong impact may cause malfunctioning.

- If the batteries lose all power all recorded data and settings will be lost. Please make sure
to change the batteries before they lose power.

- Battery life varies depending on recording conditions and battery quality. Life may be
shorter than published.

- Battery terminals may provide insufficient contact due to age or vibration. This may lead
to data loss so please be sufficiently careful.

- If the unit will not be used for a period of time, for safety reasons please remove the
battery. They may leak and lead to malfunctioning.

- This unit is not waterproof. Do not use in an area where contact with water may occur.
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/\ Handling Precautions

- Dropping the unit or exposing it to a strong impact may cause malfunctioning.

- If the batteries lose all power all recorded data and settings will be lost. Please make sure
to change the batteries before they lose power.

- Battery life varies depending on recording conditions and battery quality. Life may be
shorter than published.

- Battery terminals may provide insufficient contact due to age or vibration. This may lead
to data loss so please be sufficiently careful.

- If the unit will not be used for a period of time, for safety reasons please remove the
battery. They may leak and lead to malfunctioning.

- This unit is not waterproof. Do not use in an area where contact with water may occur.

/\ Placement Precautions

- Condensation may occur if the unit is moved from one environment to another where
the difference in temperature is great. Use the unit in an environment where the ambient
temperature is from -10 to 60 °C and the humidity is 90% RH or less.

- Do not leave the unit in direct sunlight or in excessively hot or humid places for long
periods of time. It may cause fire or otherwise cause the unit to malfunction.

- Do not expose the unit to harmful gases or chemicals. It may cause corrosion and / or
other danger to the unit and to people handling the unit.

- Exposing the unit to mechanical vibration may cause insufficient contact and data loss.
Make sure to place the unit in a steady environment.

- Avoid placing the unit in an area exposed to strong magnetic fields.
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Software User Agreement

Escape Clauses
- T&D Corporation does not guarantee the operation of Hi for Windows.

- T&D Corporation shall not accept any responsibility for any damage whether direct or
indirect that results from the usage of Hi for Windows.

- Specifications of Hi for Windows may be subject to change and service may be
terminated without advance notice to the user. In such a case, T&D Corporation shall not
be responsible for any damages, whether direct or indirect, from the inability to use Hi for
Windows.

- T&D Corporation has no obligation to correct any defects found in Hi for Windows.

Copyright

- All copyrights for Hi for Windows, including all of the programs and all related documents,
are the sole property of T&D Corporation.

- The reprinting or redistribution for commercial purposes whether in part or in whole, in
magazines or as a part of any product is strictly forbidden without the expressed consent
of T&D Corporation. Any inquires concerning commercial redistribution should be
directed to the Sales Department of T&D Corporation.

- Please do not attempt to make any changes or modifications to Hi for Windows.

4 introduction



What is Thermo Recorder TR-81 ?

This product is a thermo recorder that makes use of a platinum resistance
sensor to measure and record temperature. Recorded data is then

downloaded into a computer using our special software where it can be
easily displayed in table or graph form.

Basic Functions
- Designed to be used with a three wire Pt100 Temperature Sensor.
- Measurement Range is from -200 to 600 °C.

- The unit has two separate channels for measuring and recording
temperature.

- Data capacity is 8,000 readings x 2 channels.

- One Lithium Battery allows recording for 5-8 months.

Basic Functions of Hi for Windows®

By utilizing our special software you are able to download all recorded data into
your computer where it can be easily made into graphs and tables for printing,
saving or saving as text file data.

- Can process and display up to 8 channels at the same time.

- Can create a wide array of graphs with ease.

- Can create a graph for a chosen period.

- Automatically calculates and displays the highest and lowest values as
well as the average in graph or table form.

- The text file data can be manipulated by all popular spreadsheet software.
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Contents of Package

The following items are included in the package.

Thermo Recorder

Hi rWindows*

1 Thermo Recorder Unit 1 Software disk 1 Communication Cable
(TR-81) (Hi for Windows®) (RS-232C: D-SUB 9 pin)

o) -

1 Lithium Battery 1 Attachment Plate 1 User's Manual
(1 screw)

How to use the Attachment Plate

Use the attachment plate to hang the %
Thermo Recorder on the wall, etc. o
(
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Part Names and Functions

[The Front]

LCD display

—

HUELYHI

Thermo Recorder
TR-81

~ ~
INTERVAL REC/STOP
' N4

<INTERVAL>
Button

Power Switch

rowen g TADD

[The Side]

~————

For measurement

==

[The Rear]

<REC / STOP>
Button

(@ () o)

Thermo Recorder
TR-81  Lot.2001

— SENSOR: PH100. JP1100 —
CH2> FATBTB]
CH1 > [B]

Battery
Cover

Sensor Connection
Terminal

Channel 2

U

D D
Tl ol

Channel 1 \

ClIGTO!
T ol o

Sensor Connection Terminal ENLARGED

——Communication cable jack
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Explanation of the LCD Display

| I
[

IS e o ] F.]
s |oF B REET }@
o|aBBBERE

P$1 00 ENDI*_ESS ONE}'IME

R

(O [EE4...Recording Indicator.

@ .afl...Amount of Recorded Data.
[DISPLAY] Endless Mode... _al Indicates recording will continue.

-4l —~ nil/
« T “U™ OneTime Mode...Changes to FULL and recording stops.

@ [@...Indicates communication in progress.

@ XNd...Battery Life Warning.

® e88888...Displays Data Measurement for Channel 1.
®e868E8...Displays Data Measurement for Channel 2.

@ °c °F...Temperature Unit Display.
Display unit can be changed via. computer.

Sensor Type (Pt100)

@ Recording Mode

ENDLESS: When the recorded data goes over 8000 units the oldest data is overwritten
and recording continues.

ONETIME: When the recorded data reaches 8000 units the REC indicator goes off and
recording stops.
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Pt100 ENDLESS

BATH

COMMUNICATING

The COM mark appears when communication is taking place between the unit
and your compulter, i.e. when setting up recording, or downloading data.

FULL

The FULL mark appears when 8000 units of data have been recorded in
ONETIME Mode. This indicates that recording has stopped and it is important
to download the data into your computer as soon as possible.

OVER THE MEASURABLE RANGE

The Hi mark indicates that the temperature is over the measurable range of
600°C.

BELOW THE MEASURABLE RANGE

The Lo mark indicates that the temperature is below the measurable
range of -200°C.

BATTERY LIFE WARNING

The BAT message appears whenever the battery power is low. Re-
cording is still possible while lamp is on, but when blinking recording
will be discontinued. Please change the battery as soon as you see
the warning lamp come on.

SLEEP MODE

The battery lamp will begin to blink when power is very low, record-
ing will stop and the unit will automatically go into sleep mode. It is
important to change the battery before it begins to blink.
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Preparing the Thermo Recorder

Install the Battery

1. Using a coin, turn the battery cover lock as shown in figure 1 to open cover.

\

Figure 1: Backside of Main Unit
2. Install Lithium Battery (CR2) as shown in figure 2.

- Use only new batteries.
- Make sure the battery is in the right direction.

Figure 2: Backside of Main Unit

3. Turn the cover lock in the opposite direction of figure 1 to close cover.

Connect the Sensor

1. To connect the sensor, loosen the screws of the channel to be connected.

» Screw

Channel-2—
Channel4+—

Backside of Unit Sensor Connection Terminal
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2. Connect Sensor to Terminal, making sure to follow directions on the sticker
on the backside of unit. (See figure below)

Thermo Recorder
TR-81 Lot.2001

T&D corporatioN
— SENSOR: Pt100, JPt100 —

Sticker on Backside

Channel 2 |

Channel 1 —

Sensor Connection Terminal

[Sensor Wiring Figure]

- Usually all three wired platinum resistance sensors are wired as in the figure below. Terminals are
represented with the letters A / B or color red / white.

© A (red) A (red)
s © B (white) » B (white)
® B (white) B (white)

*In the case of a 4-wire sensor, one of the A wires will be left unused.

3. After connecting the sensor, tighten the screws to prevent slipping.

Turn Power On
- The back up power function ensures no data loss even if the power

switch is turned OFF.

POWER
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Replacing the Battery
Time to change the battery

* Once the BAT lamp appears on the display make sure to change the battery as
soon as possible. If you change the battery before the BAT lamp begins to blink,
recording will continue uninterrupted and without any loss of data.

* If the batteries go completely dead, all recorded data and recording settings will

be lost, so please be attentive to the BAT lamp.

(

T ]

o /5

110

B {5
Pt100 ENDLESS

* The following chart can give you a general idea as to battery life.

Recording Int. of more than 2 se¢’

Recording Int. of 1 second

Time before BAT lamp (warning) appears. Maximum 8 months

Maximum 5 months

- The main unit can remain in working condition for about 2 minutes without a battery.
- Battery life depends on many conditions including the recording environment, the recording interval, the amount
of communication, the surrounding temperature, and others. This explanation is based on using a new battery

and in no way should be taken as a guarantee of battery life.

After changing the battery
* If you changed the battery when the BAT lamp was on.

113
8 | icH. trouble.

PHOO  ENDLESS

*

ey

Note:

‘o Returns to same condition as before lamp
LI = e = Change batiery =ujp appeared. Recording continues without

If you changed the battery when the BAT lamp was blinking.

Change batter The power automatically goes off. Make
=-> 9 Y =% sure to turn back on.

If the BAT lamp is blinking make sure to download all data as soon as possible. If you press the [REC/
STOP] button on the main unit a new recording session will begin and all previously recorded data will

be automatically deleted.
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Installing the Software

=

Start Windows and login using a User Account with Administrator

(Computer Administration) rights.
2. Place the CD-ROM into your CD or DVD drive.
3. The [Install Program] window will appeatr.

If the [Auto Play] window appears:

Click on [Run setup.exe].

If the [Install Program] window does not appear automatically:
Click on the [setup.exe] icon in the CD/DVD drive.

4. Follow the directions as they appear to complete the installation.

If a window appears asking if you would like to install this device
software, click [Install].

5. After installation, “Hi for Windows” will appear in the Windows Start Menu.
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Communicating with your Computer

Connecting the TR-81 to Your Computer

Connect a TR-81 data logger to your computer so that communication can
occur.

D-Sub 9 pin female. Please connect it to a

Serial Port Mark
The communication cable connection is a
port that has markings such as these.

Serial cable

* If the cable is connected to the wrong port, communication cannot take place.

* Be sure to securely connect the cable to avoid any communication failure due to a
loose connection.

Setting up the Communication Port
1. In the [Communication] Menu, select [Select Serial Port].

2. Check the COM port you wish to use from COM1 to COM9.

Select Serial Port E

Check one ~Serial Port——
& COMT
C COM? Cancel

— [OK]
button

- COM3
o~ COM4
~ COMa
~ COMa
 COM?
 COME
~ COMY

Help

ek

3. Click the [OK] button to finish the setting process.

* If no port is detected, see [Troubleshooting] on pages 24-26.
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Starting to Record

There are two ways to begin the recording process.
Start Recording via Computer

You can set the day and time you want recording to start and can set or change all
recording functions via the software.
1. Start [Hi for Windows]

2. From the [Communication] Menu choose [Start Recording...]

3. The following screen will be displayed from which all settings can be made.

Channel Name Interval Fresent Date Time J
b Satup F[Setup] buttOﬂ
- m_ ;|| G st (@ [Stop] button

Ch.2
Hacord Starting Date End Date Time -
& Frogrammed Star |— ] 2007 PR _M
/200

o [ 1R.0% 10 folp
= Imenediate Star r gl I
Recording Moda, - Unit display in Sansor Typs
Recording - e Satup Sianh [Setup Status]
& Ona=tim F Cantigrads [* = P00 — b
© Endless Loop  Fahrenhedt (* utton

- Recording Interval...1/2/5/10/15/20/30 seconds, 1/2/5/10/15/20/30/60 minutes
- Recording Mode...One Time / Endless Loop

- Temperature Unit Displey...°C (Celsius) / °F (Fahrenheit)

- Sensor Type...Pt100

- Record Starting Date...Programmed / Immediate

4. By clicking [Setup] the settings will become active. The LCD Display on the
main unit will display a blinking REC until the set recording date and time

arrives.
ReCH
o JI
a 230

- When you want to stop the recording function simply click on the [Stop] button in the
[Recording Start] display in the [Communication] pull down menu. You can cancel a
programmed start in this same way.

- When you want to check the recording settings go to the [Recording Start] display
in the [Communication] pull down menu and click on [Present Settings] and the
present settings will be displayed. YOU CAN NOT CHANGE THE SETTINGS WHILE

RECORDING.
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Start Recording via Base Unit

By pushing the REC button you can begin recording immediately as well as set or
change the recording interval
1. Setthe Recording Interval by pressing the [INTERVAL] button. Each time

you press, it will take you to the next possible interval. A pause of 3 seconds
will set the interval and return you to the main display.

[Yxl [Nx}
I [RA
10 seconds 10 minutes

2. Start Recording by pressing down on the [REC/STOP] button for more than
2 seconds; the REC lamp will appear lit on the display.

[REC )

aAnn
a L C
g- (nnn
LI LT

Pt100 ENDLESS

- With some computer models, even though you have set a programmed start and the
unit is in waiting mode, by pressing [REC/STOP] recording will begin immediately.

- While recording, Recording will stop if you hold down the [REC/STOP] button for
more than 2 seconds.

- If you want to make any changes to the settings other than recording interval please
see [Start Recording Via Computer]

Note:
If you press on the [REC/STOP] button when the REC lamp is not lit, the next recording will
begin and any former data will be automatically deleted.

- When you want to stop a recording session press the [REC/STOP] button for 2 or
more seconds.

- When you want to check the recording interval while recording press the [INTERVAL]
button and it will appear on the display. YOU CAN NOT MAKE CHANGES WHILE
RECORDING.
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Downloading Recorded Data

Make sure Communication Cable is connected to the Computer.
Make sure Communication Cable is connected to the Thermo Recorder.
- For instructions on these steps, see page 14.
Begin Downloading Data.
1. From the [Communication] menu select [Download Recorded Data...]
2. The [Download Recorded Data] screen will appear.

[Download] [Exit]
button button

Diata Display

Therma Recorder | chs = M g
Tharmo Recorder | Ché = Halp

Dewnload Condition

Madal Starting Mathod
Therma Recordes Racording Mode
Tharmo Recorder Sensor Type
Starting Date Time Interval

0 25 50 75 100%

| I I ] |

I I I I 1

0f  DData

3. Start downloading by clicking [Download]

4. After downloading has been completed click the [Exit] button and the
corresponding graph will be displayed.
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Tempareture Humidity Graph

Screen Names and Functions

- This screen is only a representation for explanation purposes and may
differ from actual screen.

- For a detailed explanation of operations use the [Help] menu.

Graph Display
@ ®

A
42307 4i23/07

4 ned 27000 Andaran

Cursor A 42307 10:12'17 Calculation Range  From 42307 10:07'47
Cursor B 423/07 10:23'25  A=~B 0 00:11°08 To 4723107 10:2713

——
LUISOL A | LUPSOL D

Room 2sec 541 69.3 75.4 5.6 T8.1 69.6 3.6 F

2sec 547 3614 102.4 259.0 899.3 86.9 2556 | °F
2sec 556 61.3 .5 16.2 ™I 45.3 69.8 F
Cooling Zsec 556 -69.2 1.7 130.9 671 -10.8 27.0 ks

FERFEEERE &

M A and B Cursor Movement Buttons
By clicking the arrow buttons, you can simultaneously move the A/B cursors.
@ A and B Cursor Buttons
Click and drag the A or B button to move the cursor to the left or right.
3 Menu Bar
Click on the desired menu in the Menu Bar to set or display each function from which
you can choose from an array of commands. They can be used to display or make
settings for the various functions for each menu.
@ Button for Moving Horizontal Axis
The time axis moves by clicking these arrow buttons.
® Horizontal Gauge Bar
By dragging the gauge you can move left and right to the data you want to be displayed.
® Button for Moving Vertical Axis
The vertical axis moves up or down by clicking these arrow buttons.
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@ Vertical Gauge Bar
By dragging the gauge you can move up and down to the data you want to be displayed.
A and B Cursor Position Information

The approximate date and time for the A and B cursor positions and the time difference
between the A cursor and the B cursor is displayed.

@ Channel Info List Display
The detailed data info for each channel 1 to 8 is displayed below the Graph Display.

Zoom in Using the Mouse

With the left button drag the mouse to outline the area you want to zoom in on.

Al
423107 42307 423107 423/07 42307
10:10'00 10:13°00 10:16"00 10:19'00 10:22°00
Cursor A 42307 10:12'17 Calculation Range From 42307 10:0747
Cursor B 423107 10:23'25 A-—B 0 00:11'03 To 423107 10:27*13

Data List Display
This is a list of the data that was displayed in graph form.

Lt Data (£
[Close] _Hely Jouaton tange 1 (in/ L o<@=——Scroll Bar: By dragging it up and down
[ Boos Y you can move to the data you want.
Date Time F S
t f:h.::'{ f'h.dl.} -'h.h= l:h.l‘!= I.h.F{ tZl’s.HI

I }
' TCh1t ch.e'

7 Maximum Value is in RED, Minimum
p t 24l is in BLUE, and Average is in PINK.
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Saving Recorded Data

If you have edited any data that was displayed in a graph, we suggest that
you save it as necessary.

3 Ways to Save Files

-In the [File] Menu, select [Overwrite All Data]

Will save any changes to file without changing File Name and Saving Location.
The same operation can be carried out from [Save] in the Toolbar.

-In the [File] Menu, select [Save All Data as...]
Save with a new File Name.

-In the [File] Menu, select [Save Displayed Data]

Save only that data in the current display.This is handy when you wish to save only the
desired data.

EX: [Save All Data as...]
1. Click [Save All Data as...] in the [File] Menu.

2. Specify the [Location] and enter a [File Name].

Save All Data As

Assign a—|I Savein: | 2 Hifor Windows ~] I». =k B

Location BF oevo RN

Enter a
File Name

File: name: L rtitl=d. THH Save .‘— — [Save]
button
Save as ype: ITH-B Sernes [“TRH) ;l Cancel |

cal

|

3. Click [Save] to complete the saving process.
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Creating Text File

By saving the recorded data as text file, you can create a file type that can
be read by common spreadsheet software.

From the [File] Menu select either [Output All Data in Text File...] or [Output
Partial Data in Text File...]

EX: [Output All Data in Text File]
1. In the [File] Menu, click [Output All Data in Text File] .

2. Designate the file name, the file type to save the data in and the location

to which the file should be saved. Then click the [Save] button to create and
save the data as a Text File document.

*Comma, Tab, Space, ang Semi-colon are codes used by common spreadsheet
software, such as Excel , when reading Text File to divide cells.

Output All Data in Text File
ASSign a—l Save in; lE}HiforWindows :J I.. I::F E5-

Location

Enter a mmm] Fiename:  [Untited TXT I Save (@— [Save]

File Name - button
Save as type: IEomma Divide Yi Cancel I
—id
Tab Divide
Semicolon Divide
Space Divide

Select the Text File Type

-The extension for the created file will be [.txt].

*Text File can not be loaded into Hi for Windows.
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Troubleshooting

Q: 1 can not communicate with my computer using serial (RS-232C)
communication, what should | do?

A: Piease confirm the following items.
Check the Main Unit

Check to make sure that there is enough battery power and that the power of the
main unit is ON.

Check the connection between the computer and the Unit.

Check to make sure that the Unit is connected to the Serial Port (RS-232C) and not
connected to a different type of communication port (printer or other).

If you are using a USB-Serial Adaptor, check to make sure that it is a Operational
Guaranteed Product

Check your Computer

Make sure that the serial port settings are correct and that the port has not been
rendered unusable by the settings.

With some computers, especially all-in-one computers the serial port serves as the
modem jack.

Use the Device Manager to check whether the COM port can be used or not.(see
p.24)

If you are using a USB-Serial adaptor cable, use the Device Manager to check that
the driver has been properly installed. If the driver is not installed properly, contact
the manufacturer of the USB-Serial adaptor cable being used.

Check to make sure that the serial port has not been rendered unusable by the
BIOS setting.

Sometimes communication will not work if a switch has been added to the serial
port (RS-232C) or an extension cable has been added to the communication cable.
If you have a computer with energy saving function settings, make sure that the
serial port has not been turned off.

If the PC has two serial ports, try connecting the communication cable to the other
port and try communicating again.

Check to see if some other communication software is in use.

If you have access to another computer, try seeing if communication works with the
other computer.

If none of the above is the cause, there may be a malfunction or product failure.
Please contact your local dealer.
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* How to check your Communication Port?

In the Device Manager it is possible to check whether the communication port is

usable or not.

If Usable:

If Not Usable:

EI ;,r Parts (COM &LF‘T)

; Communlcatlc-ns Part (COM2)
L Printer Port (LPT1)

EI “_},‘ Parts (COM &LF‘T)

o B Printer Port (LPT1)

An"!", an "x

Cc-mmumcatlons Part (COMZ)

or an "arrow" will appear

If you are using a USB-Serial Adaptor:

If Usable:

If Not Usable:

E| & Ports (COM & LPT)
: Communications Port (COM1)
Carmmunications Port (COM2)

(;,‘ Prinker Port (LPT1)

E| fa- Other devices

l “_},‘ Parts (com & LPTY

Under "Other Devices" an "!",
an "arrow" will appear.

an X" or

For details about checking a communication port, see below.
1. Open the [Control panel]-[Device Manager].

2. In the [Device Manager], click on [Port (COM&LPT)] and check to see if
under that appears [Com Port (COM1)] or [Com Port (COM2)].

If a port appears, it should be usable.

L, Device Manager

File Action ‘iew Help

== [ TS 2

=Ea

HB Network adapters
Porks (COM & LPT)

ﬂ Processors

\; System devices

3. Ifan "“I" an "x"

') Mice and ather pointing devices =

Caommunications Park (COM1)
Y Communications Part (COMZ)
% Printer Port (LPT1)

(- €& 5CSI and RAID controllsrs
@y Sound, videa and game controllars

or an "arrow" appears, the port is not usable.
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To find out details about any communication
port with an "!", an "x" or an "arrow" mark, right
click on the port and select [Properties].

Q: | cannot download recorded data, what should | do?
A

= Check to make sure that there is stored recorded data in the unit? If there is
no recorded data, downloading cannot occur
Check the LCD display of the unit; if there is no data shown to be stored in the unit
downloading cannot be carried out.

If there is recorded data stored in the unit but data cannot be downloaded
please see "Q1: | cannot communicate with my computer using serial (RS-
232C) communication, what should | do?"

Q: The images are hanging off the display screen. What should | do ?
A: The display should be set at a resolution of 640x480 dpi or higher.
Q
A

: The date and the time of the recorded data are different from the actual
date and time. What should | do?

« The Thermo Recorder takes the date and time from your computer when it is
set up. Make sure that the date and time are correct on your computer.

Q: Is the data backed up automatically?

A: ifthe battery power goes low while recording the BAT lamp will come on. If
the power decreases even more, recording will be ceased and a backup of
the recorded data will be made.

26 Other



Specifications

Thermo Recorder TR-81

Recording Channels 2 Channels
Sensors Pt100 Sensors (3-wire,4-wire)(*1)
Measurement Range -200°C to 600°C

Measurement Reliability
(when main unit is at 20°C+10°C)

+0.3°C [-200 to 80°C],

+0.5°C [ 80 to 450°C],

+1.0°C [450 to 600°C]

*No account for sensor differences related to sensor type.

Measurement Resolution

0.1°C

Measurement Current

1 mA

Starting Methods

Immediate / Programmed (by computer only)

Recording Modes

One Time / Endless Loop

Recording Intervals

1,2,5,10, 15, 20, 30 seconds, 1, 2, 5, 10, 15, 20, 30, 60 minutes

Battery 1 Lithium CR2 Battery

Battery Life Maximum 8 months

Display Temperature and Unit, Recording Settings, Battery Warning,
Amount of Data, Sensor Type and Recording Mode.

Data Capacity 8000 Readings x 2 Channels

Dimensions / Weight H123mm x W58mm x D33mm / 132 grams

Temp. and Humidity Resistance

-10to 60°C
90%RH (No condensation)

Software (Hi for Windows)

Compatible OS (*2)

Microsoft Windows 10 32/64bit

Microsoft Windows 8 32/64bit

Microsoft Windows 7 32/64bit

Microsoft Windows Vista 32bit (SP1 or later)

Display Languages (*3)

English

*1 In the case of a 4-wire sensor, one wire will be left unused.
*2 For installation, it is necessary to have Administrator (Computer Administrator) rights.
*3 We recommend using an operating system in the same language as the display language. Operation in different

languages is not guaranteed.

The specifications listed above are subject to change without notice.

Other Accessories

Communication Cable

1 RS-232C: D-SUB 9pin cable 1.5 meters

Battery

1 Lithium (CR2)

Attachment Plate

1 (includes 1 screw)

User’s Manual

1 booklet
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For product information or questions contact us at

T & D corpoRraTION

Shimadachi 817-1, Matsumoto, Nagano 390-0852 Japan

TEL:+81-263-40-0131
FAX:+81-263-40-3152

Office Hours : Monday to Friday 9:00-12:00 / 13:00-17:00
(GMT+9:00 Tokyo Time)

(T&D Website)

http://www.tandd.com/
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